CS148 Homework 3 - Ray Tracing
Grading on Monday, Oct 17th

1 Assignment Outline

This is the first assignment that has a Python coding element. Please start early! If you are rusty with Python, then we encourage you to attend office hours.

Your task is to finish the code for a Python ray tracer that interacts with the above scene in Blender. We’ve already created the scene for you in Blender and have set up the code infrastructure to access information from the scene using Blender’s Python API. You can find the scene and code all in the .blend file that came with this homework.

The provided code is missing the key lines of code that are needed to properly render the scene as a ray traced image. The above image shows the four steps of ray tracing that are currently missing in the code. Your job is to fill in the missing code for each of these steps, which are further elaborated as [Action: TODO items in this PDF]. The power of ray tracing mostly lies in the last two, right-most steps, where reflections and transmissions are added to the objects. This is a feat that scanline renderers cannot do with physical correctness.

For shading, we will need to skip ahead a bit in the course material and adopt a popular shading model called Blinn-Phong. We will cover it more in detail in a later lecture. But for now, know that the Blinn-Phong model approximates how light interacts with objects and is adopted by OpenGL and Direct3D as the default shading model. You can read more about it here.
2 Collaboration Policy

You may work with one other partner and attend the grading session together as one group. **Both partners must be present for grading though.** Discussion of the homework and quiz questions across groups on Piazza, etc is allowed as long as the answers (i.e. any code, numbers, screenshots, explanations, etc) are not explicitly posted or given out publicly. Of course, **sharing code between partners is allowed.**

3 Office Hours and Piazza

The logistics for Office Hours are the same as they were last week. Because of the enormous class size, there may be many students waiting in office hours. Out of respect to your fellow students, we ask that you try to do your own debugging before coming to office hours, so that you have a clearer idea of what to ask the CA. This will allow the CA to better help you in a time efficient manner.

Similarly, if you ask a debugging question on Piazza, then please provide as much information as you can regarding your issue. Furthermore, if you feel like you need to post your code to clarify your question, then please make your post “Private” so that only the CAs can see it and attach your code as plain text, NOT AS A SCREENSHOT! The CAs may need to run your code themselves to figure out your issue, so they would very much appreciate being able to copy and paste your code from plain text (as opposed to working with a screenshot).

4 Scripting in Blender

You will use Blender’s scripting functionality for this assignment. This section will go over how to make best use of the scripting interface.

4.1 Starting Blender from the Command Line

When doing any sort of Python development in Blender, we want to launch Blender from the command line. Doing so will let Blender output any bugs or any information you explicitly print via the Python `print()` function to the command line.

- Windows: Press the `Windows` + `R` keys on your keyboard to open the “Run” box. Type `cmd` and hit enter to open the command prompt.
  
  `cd` to the Blender installation directory. The default location is `C:\Program Files\Blender Foundation\Blender 3.3`.

  In the Blender installation directory, type `Blender.exe` to launch Blender. The following image shows the above steps in action launching a past version of Blender.
- Mac: Please refer to the official document linked here.
- Linux: Please refer to the official document linked here.

Blender will launch as usual. Open the .blend file that came with this homework from the menu bar, i.e. File → Open. You should see a workspace layout similar to the following:

These are the three main sections:
1. Left: Text Editor. We can edit and run the code in this space.
2. Top right: 3D Viewport. We can manipulate and preview the scene in this area.
3. Bottom right: Image Editor. We can view the render result as an image here.

4.2 The Text Editor

**Action:** In the Text Editor, you can switch between files using the dropdown button. Browse to a script called simpleRT_UIpanels and run it.

To run a script, press the “Run Script” button on the top bar of the Text Editor. Alternatively, if you do not see the button, then you can still run the script from the menu bar above the Text Editor with Text → Run Script. Nothing should appear in the command line if the script is executed successfully.
The `simpleRT_UIlpanels` script creates custom properties that will be used for our renderer such as material properties, light parameters, etc. It then exposes these properties through the Blender UI so that we can change them easily from user interface widgets. If none of that made sense to you, then don’t worry about it. Just know that we need to run the `simpleRT_UIlpanels` script every time we launch Blender before we can work with the main script.

Switch back to the `simpleRT_plugin` and run it. To check if everything is working, switch the Render Engine to SimpleRT from the Properties Editor. This is the new render engine that we just added to Blender by running the script. We will work on this render engine in this homework.

The UI in the Properties Editor should be refreshed. You should see the `SimpleRT Render Settings` panel in the Render tab and the `SimpleRT Dimensions` panel in the Output tab. If you still see the UI panels from other render engines, press F3 with your cursor in the 3D Viewport, and type `reload script`; hit Enter to reload all the plugins.
4.3 Editing and Debugging

**Action:** Your task is to edit the `simpleRT_plugin` to finish all the TODOs. Blender has a very friendly development environment compared to other 3D software, but it is still not on par with professional Python IDEs or professional text editors. **Most debugging information will be displayed in the command line window from which you launched Blender.** As an example, try typing some gibberish (e.g. “asdfghjkl”) on a new line in the `simpleRT_plugin` script. If you then run the script, then try to render (see next subsection), then you should get an error thrown in the command line that says: **NameError: name ‘asdfghjkl’ is not defined** Furthermore, you can write `print()` statements in the `simpleRT_plugin` script and expect to see the print out in the command line.

There are some handy shortcuts in the Text Editor. You’ll likely use the formatting operations the most:

- **Tab** for indent
- **Shift + Tab** for unindent
- **Ctrl + /** or **Cmd + /** to toggle comments

For more shortcuts in the Text Editor, please see the Blender documentation.

There is optionally a Python Console in the Blender user interface. You can see the documentation here and can use it as an interactive Python shell. Additionally, the Info Editor can be useful to display logs, warnings, and error messages. Both of these tools can make your development life easier in Blender if you master them, but if you’re just starting out, then simply working with the command line and `print()` statements should be enough for debugging.

4.4 Rendering and Saving

After you make edits to the `simpleRT_plugin` script, run the script again, and hit F12 to start the render. Alternatively, you can start the render by going to **Render → Render Image** in the top menu bar. Note that we are using **Render Image** with this render engine instead of **Render Animation** as we did with the **Workbench** render engine.

You should see the rendered image appear in the Image Editor and a progress bar in the bottom status bar:

Furthermore, the provided code in the `simpleRT_plugin` script should also be printing the elapsed and remaining time for the render in the command line. You can press the **Esc** keyboard key at any time to stop the render.

When the rendering is done, you can use **Image → Save Image** or **Alt/Option + S** from the keyboard to save the result. **With the starter code, the image should render a completely black image.**

4.5 Speeding up Rendering with Lower Resolution

To speed things up while you’re debugging, you should keep the image resolution low to make the renders fast (since the speed is based on iterations over the number of pixels). After the low-resolution image looks correct, crank up the resolution and render a higher resolution image for submission.
A quick and easy way to change the resolution is to change the resolution percentage from the Properties Editor. Go to the Output tab for the SimpleRT Dimensions panel. You can modify the % option to shrink the image resolution without changing the aspect ratio. Usually 25-50% is a good place to start and should hopefully keep your render time under 10 seconds (though it can depend on your computer specs). You will of course get a very aliased (blurry) result, but you should be able to tell if your code is working from this image.

After the image looks right to you, change the percentage back to 100 for a higher resolution image. The render will likely take a few minutes, but with this resolution, you should be able to check all the details.

4.6 Comparing Render Results

In the Image Editor, you can store up to 8 rendered images in slots and toggle between them afterward. This could be helpful when comparing the results from different versions of code, or different material properties.

To render the image to a certain slot, select that slot before rendering:

To toggle between the slots, you can use the number keys to go to the slot with the corresponding number (turn off Emulate Numpad from the Preferences) or press J and Alt + J to cycle forwards and backwards through saved renders respectively. You can see the Blender documentation for more details.

5 Checkpoints

All the TODOs are listed as comments in the simpleRT_plugin script. We recommend first reading the TODO descriptions in this PDF document first, then go to the sections in the code. The sample images in this PDF are rendered at 200%. Expect to see more aliasing in your images.

For those curious, the ray-object intersection logic is taken care of by the scene.ray_cast function from Blender. Our focus in this homework will be on how to use the information from the intersection to figure out the correct color calculations and light bounces.
5.1 TODO 1: Shadow Ray

**Action:** This part is based on the discussion of “Shadows” in Lecture 5.

We discussed how to represent shadow rays and rays in general mathematically in lecture, but we need to think of these concepts from a different angle when representing them in code. Consider what defines a ray – you need an **origin point** and a **vector direction**.

The origin point is simply an xyz-coordinate in Cartesian space written as a vector. For instance, if we want to call the point at (1, 1, 1) “point a”, then we can write $\vec{a} = \begin{bmatrix} 1 \\ 1 \\ 1 \end{bmatrix}$.

A vector direction is geometrically an arrow pointing from a start point to an end point. Call the start point $\vec{a}$ and the end point $\vec{b}$. Then the vector direction from $\vec{a}$ to $\vec{b}$ is computed as the difference $\vec{b} - \vec{a}$, i.e. the end point minus the start point.

For purposes that will become clearer later in this homework, it is often good practice to **normalize** direction vectors after you compute them. Normalizing vectors means making them unit vectors, i.e. giving them unit length. Mathematically, we do this by dividing the vector by its magnitude or size. In Python, there is a convenient `.normalized()` function that you can use. As an example: `my_normalized_version_of_v = v.normalized()`.

When we ray trace, we start by shooting a ray that starts from our camera or eye. That is the origin point of the ray. The direction of the ray is the vector direction starting from the camera and ending at a pixel (call it $p$) on our film plane. We continue tracing along this direction past our film plane into our scene until we hit aka intersect an object. When we finally intersect an object, we start doing operations to compute the color that the ray should gather from the object. This color is then added to a running sum keeping track of the color of the pixel $p$ for rendering.

For this part of the homework, you need to:

1. Construct the shadow ray(s).
   
   Conceptually, a shadow ray is a ray that starts from the intersection of the ray that we are ray tracing and the object it hits. In the code this intersection is given to you as `hit_loc`. That is the origin of the shadow ray.
   
   The vector direction of a shadow ray is the vector starting from the intersection point and ending at a light. Notice how the TODO in the code is within a loop over all the lights. You can access the position of the light in the current iteration of the loop with `light.location`.
   
   You need to compute both the shadow ray origin and the shadow ray direction.

   
   You need to modify the shadow ray origin slightly to account for spurious self-occlusion as discussed in lecture. The normal direction at the intersection has been provided for you as `hit_norm`, and a small $\epsilon$ value has been given to you as `eps` (it’s just simply $10^{-3}$, i.e. some small number).

   You should get the following image if you’ve coded everything correctly.
5.2 TODO 2: Diffuse (and Specular) Light

**Action:** This part is based on the discussion of the diffuse light contribution in the “Color Accumulation at [the] Intersection Point” from lecture. Read the comments above the TODO 2 in the script carefully.

Note that you may need to convert the diffuse color to a Python array with `np.array` to avoid a type mismatch when multiplying it with the light intensity. This is because the diffuse color is declared as a Python vector, but needs to be converted to a Python array for an element-wise multiplication with another Python array.

To compute the dot product of two vectors in Python, you can use the `.dot()` function. For instance, the dot product between vectors $\vec{v}_1$ and $\vec{v}_2$ would be: $\vec{v}_1 \cdot \vec{v}_2$.

You should get the following image if you’ve coded everything correctly.
Look for the UNCOMMENT BELOW comments. There should be 3 of them. Uncomment all 3 lines to enable the specular light contributions. We will go over specular light in a future lecture.

You should now get the following image, with shiny highlights on the yellow half sphere.

![Image](image_url)

5.3 TODO 3: Ambient Light

**Action:** This part is based on the discussion of the ambient light contribution in the “Color Accumulation at [the] Intersection Point” from lecture.

The ambient contribution is computed as the product of the diffuse color and the ambient color. Like in the last step, you may need to convert the diffuse color to a Python array with `np.array` to avoid a type mismatch.

You should get the following image if you’ve coded everything correctly. Notice how the shadow of the black block on the orange half disc has gotten lighter.

![Image](image_url)
5.4 TODO 4: Recursion and Reflection

**Action:** This part is based on the first half of Lecture 6.

Suppose our ray is initially traced as the purple ray and intersects the blue edge of a reflective object. The ray gets reflected by the object to then continue in a different direction from which it began. In code, we represent the reflected ray as an entirely new ray object. This new reflected ray is represented by the light-green ray in the diagram pointing to the lower-right.

To represent a new ray object, we need the new ray origin and the new ray direction. Once we have these two characteristics to define the reflected ray, we need to trace the new ray. This is done via recursion in code by calling the `RT_trace ray` function within itself.

The 2nd and 3rd arguments to the `RT_trace ray` function ask for a ray origin and ray direction respectively. To trace the new, reflected ray, we simply just need to call the `RT_trace ray` function with the reflected ray’s new ray origin and the reflected ray’s new ray direction.

1. First, you need to compute the direction of the reflected ray. This is known as \( D_{refl} \) in the “Reflected Ray” slides.

   Note the purpose of the dot product in the equation for \( D_{refl} \). The dot product between two unit, normalized vectors is the cosine of the angle between them. So the two vectors involved in this dot product should be normalized beforehand. These two vectors are the original ray direction and the normal vector to the surface that the original ray intersected.

2. After you have the reflected ray direction, you need to compute the new origin of the reflected ray. Naively, you may think this is simply the intersection point, i.e. hit.loc in the code. However, you need to account for spurious self-occlusion as discussed in lecture and offset this intersection point in the normal direction by some small \( \epsilon \) value.

3. Once you have the new origin and the new direction of the reflected ray, you need to recursively trace the ray. This is done by calling the function `RT_trace ray` with the ray origin and ray direction arguments replaced with the new origin and new direction of your reflected ray.

   Note that throughout the `RT_trace ray` function, you use the passed in ray direction argument for various dot products, which all want normalized vectors. So as a good general practice, you want to normalize the reflected ray direction when passing it into the function.

   You should also pass in \( \text{depth} - 1 \). We use the `depth` variable to keep track of how many recursive steps we take before terminating.

4. The function `RT_trace ray` returns a color. This is the color gathered by the reflected ray when it finally terminates. We call this the reflection color aka \( L_{refl} \).
$L_{\text{reflect}}$ is then weighted by the object material’s reflectivity value, usually written as $k_r$. It is this weighted color that is then added to a running sum of the color that we are computing for the pixel (the “Color Accumulation at [the] Intersection Point”).

You should get the following image if you’ve coded everything correctly. Notice how the bowl at the top as well as the blue cube now reflect objects in the scene.

5.5 TODO 5: Fresnel

**Action:** This part is based on “Fresnel Equations” slides of Lecture 6.

The Fresnel equations model the change in the strength of a reflection based on the angle that our ray makes with the object it intersects (aka the angle of incidence). The equations can be simplified with Schlick’s Approximation as discussed in lecture to compute a reflectivity value $R(\theta)$, also commonly written as $k_r$.

When computing the $R_0$ ratio, remember that $n_1$ is always the index of refraction (IOR) of the medium in which the ray starts. $n_2$ is always the IOR of the medium that the ray intersects. In the scene for the homework, all reflections occur from a ray originating from the air and bouncing off an object. So, $n_1$ is always the IOR of air, which is 1, and $n_2$ should be the IOR for the object, which is given to you as `mat.ior`.

To compute the cosine term for Schlick’s Approximation, remember that the dot product between two unit, normalized vectors is the cosine of the angle between them. The angle we are examining is the angle between the ray direction vector and the object’s surface, which is represented by the normal vector at the intersection.

You should get the following image if you’ve coded everything correctly. Notice the reflections of the ground and orange half-disc on the black block.
5.6 TODO 6: Transmission

**Action:** This part is based on the “Transmission” slides of Lecture 6.

See the picture on the right. Suppose our ray is initially traced as the purple ray and intersects the blue edge of a transparent object. Due to the material properties of the object, the purple ray is refracted and then transmitted through the object. In code, we represent the transmitted ray as an entirely new ray object. This new transmitted ray is represented by the light-green (middle) ray in the diagram.

Now, suppose instead of the purple ray, the ray that we are examining in our recursion is actually the light-green (middle) ray in the diagram. This ray originated inside an object and is traced until it intersects the orange edge of the object. The ray is then refracted and transmitted out of the object into the air. In code, we represent the transmitted ray as an entirely new ray object. In the diagram, the transmitted ray is represented by the orange ray.

In both cases, we represent the transmitted ray as an entirely new ray object. As you should know by now, to represent a new ray object, we need both the new ray origin and the new ray direction. Furthermore, we need to recursively trace the new ray by calling the `RT_trace_ray` function again with the new ray origin and the new ray direction.

1. First, you need to compute the index of refraction (IOR) ratio: $\frac{n_1}{n_2}$. The tricky part here is that $n_1$ and $n_2$ change depending on where the ray starts. $n_1$ is always the IOR of the medium in which the ray starts for the transmission. $n_2$ is always the IOR of the medium in which the ray ends up for the transmission.

So if the object is starting in the air and is going through a transparent object to end up inside the object, then $n_1$ should be the IOR for air, which is 1, and $n_2$ should be the IOR for the object, which is given to you as `mat.ior`.

On the flip side, if the ray starts inside the transparent object and is going through it to end
up in the air, then the values flip. You can check if the ray starts inside the object with the `ray_inside_object` boolean.

2. Once you have the IOR ratio, then you can compute the direction of the transmitted ray, known as $D_{\text{transmit}}$ in the “Transmitted Ray” slides. One thing to note though is that you need to account for total internal reflection.

You only proceed with computing $D_{\text{transmit}}$ if there is no total internal reflection.

3. Similar to the previous steps, you need to recursively trace the ray. Again, this is done by calling the function `RT_trace_ray` again with the ray origin and ray direction arguments replaced with the new origin and new direction of your transmitted ray.

The origin of your transmitted ray is the intersection point, aka `hit_loc`. But also remember that you need to account for spurious self-occlusion. It’s a bit trickier in this case because transmitted rays are going through the object (as opposed to reflected rays which are bouncing off the object). This means you’ll have to handle the $\epsilon$ offset in the normal direction slightly different from what you did in the reflection case.

The direction of the transmitted ray is your computed $D_{\text{transmit}}$. Remember to normalize it, because it will be used in the dot products that you wrote for the previous steps throughout the recursion.

Remember to also pass in `depth - 1`.

4. As with the previous steps, the `RT_trace_ray` function returns a color. In this case, it’s the transmission color, aka the color gathered by the transmitted ray when it finally terminates: $L_{\text{transmit}}$. The transmissiveness and reflectivity ($k_r$) of an object are theoretically supposed to add up to 1, so we weight the returned color by $(1 - k_r)$ as well as the object material’s transmission properties given in `mat.transmission`. After weighting the returned color with these values, we add it to running sum of the pixel color like we did in the previous steps (the “Color Accumulation at [the] Intersection Point”).

You should get the following image if you’ve coded everything correctly. Notice how the black block has turned into glass, allowing you to see the orange cone through it.
6 Quiz Questions

During the grading session, the CA will choose one of the following questions at random to ask. Please be prepared to give a brief (~1 min) answer based on the lecture material.

- Describe two of the three ways we discussed in class on how to compute a ray-triangle intersection. You don’t need to explain all the mathematical details, but give enough details to show that you know the difference between the methods.

- Why is transforming a normal vector between object and world space different from transforming an object? What is one reason for why we want the normal vector(s) to an object’s surface in world space coordinates?

- Elaborate on the idea of accounting for spurious self-occlusion. What problem arises from spurious self-occlusion when we ray trace? How do we get around this problem?

- Explain the idea of total internal reflection. Conceptually, when does this happen, and what effect does it have on the transmission of light through a material?

- What does Beer’s Law say about light as it travels through a medium? What happens to the intensity of the light as it travels a larger and larger distance? Fun fact: if we wanted to be fully correct with our ray tracer code, then we should be implementing Beer’s Law for transmissive rays as they go through (e.g. glass) objects. However, we aren’t doing it here for simplicity.

7 How to Submit / How to get Graded

On Monday, October 17:

- if you are assigned the 2-3 or 3-4 PM time block, then please join this Zoom call.

- if you are assigned the 5-6 or 6-7 PM time block, then please join this other Zoom call.

Those with alternative times as scheduled via email should join the 2nd (5-7) Zoom call at the same alternative time window.

If you are working with a partner, then both of you may get graded together at a single time block. Both of you need to be in the Zoom call to get graded. When one partner is let in, they should tell the CA to also let the other partner into the same room.

8 What to Demo / Submit

During the grading session, please screenshare with your CA and have all of the following ready to show beforehand:

- (0.5 pt) The image for TODO 1: Shadow Ray rendered at 960 x 540 with at least 50% resolution.

- (0.5 pt) The image for TODO 2: Diffuse (and Specular) Light rendered at 960 x 540 with at least 50% resolution.

- (0.5 pt) The image for TODO 3: Ambient Light rendered at 960 x 540 with at least 50% resolution.
• (1 pt) The image for TODO 4: Recursion and Reflection rendered at 960 x 540 with at least 50% resolution.

• (0.5 pt) The image for TODO 5: Fresnel rendered at 960 x 540 with at least 50% resolution.

• (1 pt) The image for TODO 6: Transmission rendered at 960 x 540 with at least 50% resolution.

• (1 pt) Answer the quiz question given by the CA correctly.